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EXOPEMP

Employee Maintenance
EXO Payroll
This training manual has been 
developed by the MYOB Enterprise 
Division - Professional Services Team 
for use in the delivery of training.

This manual uses a simple step-by-step 
approach to give you the skills and 
knowledge necessary to set up and edit 
employees in EXO Payroll.

This manual has been designed for the 
following MYOB product:

• EXO Payroll
Course duration: 0.5 hrs
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Participants
This course is aimed at:
• Users of EXO Payroll.

Prerequisites
Basic PC experience is required.
Understanding of payroll processes and procedures.

Instructional method
The instructional method uses examples of system configuration.The instructional method 
makes use of trainer-led exercises. Each unit concludes with a Review Task. 

Conventions used in this manual
• Objects such as buttons or icons that you must click or select are shown in bold.
• Information to be entered (typed in) or selected is shown in bold and italics.
• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in 
the actual product due to configuration settings.
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Symbols used in this manuals

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills you have 
just learnt, or as a review task at the end of the unit 
to consolidate what you have learnt.

Written Review task … to complete written questions to review the 
content covered in the unit.

Optional Challenge … to complete this task if you have finished early 
and are looking for an extra challenge.

Tip … about helpful tips

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for EXO Payroll.

Reference … where to go to find more information.

Skills Checklist … to tick off a list of skills that you have learnt during 
the unit.
© Copyright 2012 MYOB Technology Pty Ltd
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Objectives

Upon completion of this course you will be able to:

• Set up Employees

Before you begin:
This training manual has been designed for use with the Demonstration Company and 
assumes that you do not have any other MYOB Employer Services products, e.g EXO Time 
and Attendance.

1 From the Login screen, double-click on the Demonstration Company.

2 From the Utilities menu, click on Setup Exo Payroll.

3 From the list of setup areas, click on Other Setup.

4 Click on the Wages section.

5 Ensure that the options “Do not copy wages for Time and Attendance employees” 
and “Do not copy wages for Rapid employees” are not selected.

6 Click on the Save button or press F10.
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Function Keys

F1 Help

F2 Maintenance Menu

F3 Change Sort

F4 Add

F5 Edit

F6 Delete

F7 Previous

F8 Next

F9 Find/Print

F10 Save

F11 About Screen

F12 Employee Notes

Page Up/Page Down Switch between pages

Alpha/Numeric Keystrok Activates incremental search of picklists

Spacebar Opens dropdown lists

Home Skips to start of field

End Skips to end of field

Tab Skips to next field

Shift+Tab Skips to previous field

Ctrl+H Activates the hide screen, which can only be unlocked using the password 
you logged in with.

Ctrl+D Activates the Diary. This is a form of daily planner, providing you with a 
place to enter comments on any given day for payroll company-related 
tasks, appointments and reminders.

Ctrl+L Activates the Calculator.
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Employee 
Maintenance
In this unit, you will learn 
how to set up new 
employees, edit an 
existing employee’s 
records, set up leave 
entitlements and set up a 
standard pay. 
By the end of this unit, you will be able to:

Set up a new employee

Edit an existing employee record

Set up Leave entitlements

Set up a Standard Pay
 1
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Overview

This section details the steps and areas that need to be completed when setting up a new 
employee.
The Employee Maintenance is divided into the following 6 sections:

Employee Details
This section contains the employee’s personal details and tax classification.

Leave Entitlements
This section contains the employee’s entitlements to Annual Leave, Personal Leave and 
Long Service Leave.

Other
This section contains the employee’s e-mail address, Rostered Days Off entitlements (if 
applicable) and other options relating to how this employee’s payroll information is 
entered.

User Defined
This section contains a number of user definable fields to store additional employee 
information.

Notes
This section contains all the employee’s payment history notes.

Standard Pay
This section contains the employee’s pay template of what they are normally paid per pay 
period.

To Add a new Employee

1 From the File menu, select New Employee.

Add Employee
© Copyright 2012 MYOB Technology Pty Ltd
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Unit 1—Employee Maintenance
2 The Enter New Employee Code field will automatically display the highest available 
employee number. Override this number if you want to assign a different number to 
the employee.

3 Click on the Add Employee button to add the employee to the system.

N O T E
When adding a new employee, you do not have to save after completing each section. You 
can save once you have completed the employee’s setup.

To Edit an existing Employee

1 From the File menu, select Open Employee.

2 In the Enter Employee Code or Alpha Code field, enter either the employee code or 
their alpha code.

T I P
You can also find the employee by clicking on the Find button or pressing F9. You can also change the 
order from Code to Alpha Code by clicking on the Change Sort Order  button, using F3 or by clicking 
on the column headings.

3 Press , click on the Find button or press F9 to load the employee’s details.

Find Employee
© Copyright 2012 MYOB Technology Pty Ltd
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Employee Details

To enter an employee’s personal details:
Click on the Employee Details tab if this screen is not active.

Enter the follobwing Details:

Employee Maintenance - Employee Details

Field Description

Surname, First Names Enter the employee’s Name in these fields.

Alpha Code
This code is used as the employee’s Alpha Sort 
and is typically the first 8 characters of their 
surname.
Note: The Alpha Code must be unique.

Start Date Enter the employee’s date of employment.

Cost Centre
Enter the employee’s Default Cost Centre. Click 
on the  button to get a list of your Costs 
Centres.

Department Enter the employee’s Department. Click on the  
button to get a list of your Departments.
© Copyright 2012 MYOB Technology Pty Ltd
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Pay Frequency
From the dropdown list, select the employee’s 
pay frequency.
Note: If the employee is a Casual, no frequency is 
required.

Address Details
Enter the employee’s address details.
Note: Only complete the Country field if the 
employee resides outside Australia.

Telephone Enter a contact number for the employee.

Mobile Enter a mobile number for the employee.

Occupation Enter the employee’s occupation or job title.

Apprentice
Select this option if the employee is an 
Apprenctice. Click on the Apprentice button to 
enter the details of their apprenticeship.

TFN If this record is for an Employee, enter the 
employee’s Tax File Number.

ABN If this record is for a Contractor, enter the 
contactors’ Australian Business Number

Tax Classification Select the appropriate Tax Classification from the 
available options.

Earnings are Not Liable for 
Payroll Tax

Select this option if this employee’s earnings are 
not liable for payroll tax paid by the company.

WorkCover
To use the default WorkCover rate to calculate 
your WorkCover payments, select the option Use 
WorkCover rate.

Male/Female Select the employee’s Gender.

Salary/Wage

Specify if the employee is Waged (paid an hourly 
rate) or Salaried (paid a fixed dollar amount). For 
a Salaried employee, also select the option Allow 
Overtime if the employee is paid for overtime 
hours.

Standard Hours per pay

Enter the employee’s standard hours per pay 
period.
Tip: Use the Full-Time equivalent for part-time 
employees.
Note: This field must be completed for all 
employees entitled to leave.
Note: If the employee is entitled to Rostered Days 
Off, this field must reflect the number of hours 
worked not paid.
© Copyright 2012 MYOB Technology Pty Ltd
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Full-Time

These employees are employees on a permanent basis and are commonly entitled to 
leave provisions and notice of termination.

Part-Time
Employees working less than 38 hours per week are classed as part-time employees, yet 
still have regular, set hours of work. Part-time employees generally receive a pro-rata 
equivalent of the benefits and entitlements a full-time employees receives.

Casual
Casual employees do not work set hours and are called upon to work ad-hoc hours. 
Casuals typically do not have guarantee of work beyond their current hiring.

After you have entered all the employee’s personal details, click on the Save button or 
press F10 to ensure the employee is added.

Standard Hours per day

Enter the employee’s standard hours per day .
Note: If the employee accrues RDO’s on RDO’s, 
enter the standard hours the employee works per 
day. The employee will be paid these hours when 
taking an RDO with the RDO accrual being 
deducted from these hours, e.g. if the employee 
normally works 8.00 hours, 0.05 will be deducted 
and the employee is paid 7.60 hours for the day.

If the employee does not accrue RDO’s on RDO’s, 
enter the standard hours the employee is paid 
per day. The employee will be paid these hours 
when taking an RDO with no RDO accrual 
deducted from these hours, e.g. if the employee 
is normally paid 7.60 hours, no RDO accrual will 
be deducted and the employee is paid 7.60 hours 
for the day.

Full-Time/Part-
Time/Contractor

Select the employee’s Hours of employment.

Trade Labour Content
If this record is for a Contractor, enter the 
percentage at which the their payroll tax is 
calculated.

Permanent/Casual/Temporary Select the employee’s Term of employment.

Birth Date Enter the employee’s date of birth.

Due Back Date Leave this field blank.

Annual Review Enter the date of this employee’s next annual 
review. This is an optional field.
© Copyright 2012 MYOB Technology Pty Ltd
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Unit 1—Employee Maintenance
Edit the employee to complete the remaining areas. (Refer to “To Edit an existing 
Employee” on page 3)
© Copyright 2012 MYOB Technology Pty Ltd
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Leave Entitlements

Click on the Leave Entitlements tab if this screen is not active.

T I P
To view a breakdown of the employee’s leave balances, click on the Edit button under the Other 
Details section for the respective leave type.

Annual Leave

To set up an employee’s Annual Leave entitlements

1 In the Group field, assign the appropriate Annual Leave Group.

Employee Maintenance - Leave Entitlements
© Copyright 2012 MYOB Technology Pty Ltd
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Unit 1—Employee Maintenance
2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.

5 The Entitlement Units field shows how much leave the employee will accrue each 
year, based on the rules you’ve specified in the Annual Leave Group.

6 The Balance field shows the employee’s total entitlement to Annual Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s Annual Leave 
Paid will be costed. 

To enter balances for Annual Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance for 
Annual Leave.

2 In the Carry Over field, enter the hours of Annual Leave carried over from your 
previous system.

3 Click on the Save button or press F10.

Employee Details - Leave Entitlements - Assign Annual Leave Group

Employee Maintenance - Leave Entitlements - Annual Leave Balances
© Copyright 2012 MYOB Technology Pty Ltd
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Personal Leave

To enter an employee’s Personal Leave entitlements

1 In the Group field, assign the appropriate Personal Leave Group. 

2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.

5 The Entitlement Units field shows how much leave the employee will accrue each 
year, based on the rules you’ve specified in the Personal Leave Group.

6 The Balance field shows the employee’s total entitlement to Personal Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s Personal 
Leave will be costed. 

To enter balances for Personal Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance for 
Personal Leave.

2 In the Carry Over field, enter the hours of Personal Leave carried over from your 
previous system.

Employee Maintenance - Leave Entitlements - Assign Personal Leave Group

Employee Maintenance - Leave Entitlements - Personal Leave Balances
© Copyright 2012 MYOB Technology Pty Ltd
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3 Click on the Save button or press F10.

Long Service Leave

To enter an employee’s Long Service Leave entitlements

1 In the Group field, assign the appropriate Long Service Leave Group.

2 The following screen will appear:

3 Select the option From the employee’s start date.

4 Click on the Ok button.

5 The Entitlement Units field shows how much leave the employee will accrue each 
year, based on the rules you’ve specified in the Long Service Leave Group.

6 The Balance field shows the employee’s total entitlement to Long Service Leave.

7 The Cost Centre field records the Cost Centre to which the employee’s Long Service 
Leave Paid will be costed. 

To enter balances for Long Service Leave

1 Click on the Edit button under Other Details to alter the employee’s Balance for 
Long Service Leave.

Employee Maintenance - Leave Entitlements - Assign Long Service Leave Group

Employee Maintenance - Leave Entitlements - Long Service Leave Balances
© Copyright 2012 MYOB Technology Pty Ltd
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2 If the employee has outstanding Long Service Leave accrued prior to 16 August 1978, 
enter the hours in the Hours Prior to 16/08/1978 field.

3 If the employee has outstanding Long Service Leave accrued between 16 August 
1978 and 17 August 1993, enter the hours in the Hours between 16/08/1978 and 
17/08/1993 field.

4 If the employee has outstanding Long Service Leave accrued after 17 August 1993, 
enter the hours in the Hours after 17/08/1993 field.

5 Click on the Save button or press F10.

To load Long Service Leave Accrual (Year To Date)
The Year-To-Date value for Long Service Leave is loaded via a special utility. This utility 
(LoadLSL) is located on your Employer Services CD. Once this utility is installed, it can be 
accessed from the Special menu in EXO Payroll.

1 From the Special menu, select Special Applications.

2 Select Load YTD LSL and click on Save or press F10.

3 In the Year to Date field, enter the year-to-date accrual for each employee.

4 Click on the Exit button.

5 Click on the Exit button or press Esc.

Load Long Service Leave Year-To-Date accrual
© Copyright 2012 MYOB Technology Pty Ltd
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Other options
If the Annual Leave Group assigned to the employee includes a Leave Loading rate, the 
option Entitled to Leave Loading at x.xx% will automatically be selected, with the Leave 
Loading rate from the Annual Leave Group shown.

I M P O R T A N T
If the option Entitled to Leave Loading is selected, an Annual Leave Group with a Leave 
Loading Rate must be assigned to the employee.

The Days of sick leave without a medical certificate field shows the number of days Sick 
Leave the employee has had in their current entitlement year without providing a medical 
certificate.
© Copyright 2012 MYOB Technology Pty Ltd
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Other

Click on the Other tab if this screen is not active.

Email
You can record e-mail addresses for your employees. If you are going to e-mail payslips to 
your employees, you must complete the following fields:

1 In the Email address field, enter the e-mail address where the employee’s payslip 
should be sent.

2 In the Password field, enter the password with which their payslip will be encrypted.

T I P
If you have purchased EXO MyStaffInfo, the employee’s e-mail address and password will be their 
login for the MyStaffInfo website.

Employee Maintenance - Other
© Copyright 2012 MYOB Technology Pty Ltd
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Rostered Days Off

To set up an employee’s Rostered Days Off:

1 Click on the option Track RDO’s for this employee.

2 Enter the following Details:

To enter balances for Rostered Days Off

1 In the Available hours field, enter the employee’s balance up to the last pay.

Time in Lieu
This field is used for recording time in lieu the employee has accrued.

To enter balances for Lieu Time

1 Click on the Other tab.

2 In the Time in Lieu Hours field, enter the employee’s balance up to the last pay.

Pay rounding carried foward
If you have set up the system to apply rounding to an employee’s pays, each time an 
employee’s net pay is rounded, the system will accumulate the rounded-off cents in this 
field. Once the minimum payout value is reached, this accumulated value will be 
autmatically be paid to the employee in their next pay.

Field Description

Accrue x hours for each hour 
worked

Enter the rate at which the employee accrues 
RDO’s.

Cap accrual to x hours per pay Enter the maximum number of hours the 
employee accrues RDO’s on per pay period.

Value hours at x pay rate

From the dropdown list select:
• An average to value RDO’s at an average 

rate, or
• Rate X to value the RDO’s at a specified 

hourly rate.
This value will be used for both the accrual and 
payment of RDO’s.

Available hours This field displays the employee’s RDO’s balance. 
© Copyright 2012 MYOB Technology Pty Ltd
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Rapid Employee
If you are using Rapid Load Pay and will enter this employee’s pay using Rapid Load Pay, 
select this option.

Time and Attendance Employee
If you have EXO Time and Attendance and will record the employee’s time and attendance 
information using EXO Time and Attendance, select this option.
© Copyright 2012 MYOB Technology Pty Ltd
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User Defined

Click on the User Defined tab, if it is not currently active.

User Defined Fields
This area contains user definable fields that can be used to record additional information 
on your employees.

To rename a User Defined Field

1 Double-click on the User Defined caption of the field you want to use.

2 Enter a title for this field.

3 Press Enter.

To reset the User Defined Field

1 Double-click on the title of the field.

Employee Maintenance - User Defined

Employee Maintenance - User Defined - Renaming Using Defined Field
© Copyright 2012 MYOB Technology Pty Ltd
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2 Delete the title.

3 Press Enter.

4 The following user definable fields are available:

Field Description

2 x Check boxes Used for yes/no options.

2 x Dates Used to record a date.

3 x Text Fields Used to enter short text descriptions.

1 x Number Field Used to enter a value.

1 x Comment Field Used to enter comments.
© Copyright 2012 MYOB Technology Pty Ltd
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Notes

Click on the Notes tab if this screen is not active.

This screen shows all the notes that have been entered against an employee. 
Every time an employee is paid leave, their leave entitlements are changed or their Hourly 
Rate/Salary is altered, the system automatically generates a note, which is stored in this 
area.

To Edit an exiting Note:

1 Double-click on the note you want to edit.

Employee Maintenance - Notes
© Copyright 2012 MYOB Technology Pty Ltd
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To Add a new Note:

1 Click on the Add button or press F4.

2 Enter the following details:

3 In the space provided, enter your note.

4 Click on the Save button or press F10 to save the note.

Employee Maintenance - Notes - Adding a Note

Field Description

Date This is the date on which the note is added.

Entered By This field default to the User Code of the user 
adding this note.

Note Type From the dropdown list, select the type of note 
you are adding.

Reminder Date
If you want the system to remind you of this note, 
enter the date on which you want to be 
reminded.

Recipients Click on the  button to select the Users that 
should be reminded.
© Copyright 2012 MYOB Technology Pty Ltd
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Standard Pay

Click on the Standard Pay tab if this screen is not active.
This area stores the employee’s pay template; what they are normally paid each pay 
period.

I M P O R T A N T
If changes are made to the employee’s Standard Pay after a Current or One-Off Pay is 
created, the pay will not automatically be updated with the changes. 

Employee Maintenance - Standard Pay
© Copyright 2012 MYOB Technology Pty Ltd
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Hourly Rate

To enter an Hourly Rate

1 Click on the Hourly Rates button.

2 Enter the employees Hourly Rate. If you have the option for Multiple Wage Hourly 
Rates turned on, you will be able to enter up to 9 Hourly Rates for each employee.

N O T E
You can change the description(s) of the Hourly Rate(s) from the Hourly Rates. Refer to 
your EXO Payroll user guide for more information.

3 Click on the Save  button or press F10.

Standard Pay - Hoursly Rates
© Copyright 2012 MYOB Technology Pty Ltd
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Wages

To add Standard Pay Wages

1 Click on the Wages button.

2 In the line corresponding with Ordinary, enter the standard hours the employee is 
paid in each pay period.

N O T E
If there are no lines in the employee’s Wages screen, click on the Add button or press F4 to 
add a new line.

Standard Pay - Wages
© Copyright 2012 MYOB Technology Pty Ltd
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3 Alternatively, you can click on the corresponding line and click on Edit or press F5.

4 From the Wage Rate Type field, select Ordinary.

5 The Hourly Rate field shows the rate at which hours against this pay rate multiplier 
will be paid.

6 If the employee has multiple hourly rates, enter the appropriate Hourly Rate Code in 
the Hourly Rate Code field.

7 In the Number Hours field, enter the standard number of hours the employee is paid 
in a pay period.

I M P O R T A N T
If the employee is entitled to Rostered Days Off, the value entered into the Number Hours 
field reflect the number of hours worked not paid.

8 If you want to cost the hours to a specific Cost Centre, enter the appropirate Cost 
Centre Code in Cost Centre field.

9 In the Alternative Type Desciption field you can enter an alternative description for 
this pay rate multiplier.

10 Click on the Save button or press F10 to save from this screen.

11 Click on the Save button or press F10 to save the employee’s Standard Pay Wages.

Standard Pay - Edit Wages
© Copyright 2012 MYOB Technology Pty Ltd
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Allowances

To add Standard Pay Allowances

1 Click on the Allowances button.

2 Click on the Add button or press F4.

Standard Pay - Allowances

Standard Pay - Allowances - Add Allowance
© Copyright 2012 MYOB Technology Pty Ltd
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3 Enter the following information:

N O T E
The availability of these fields are determined by the setup of the Allowance.

4 Click on the Save button or press F10.

5 Click on the Save button or press F10 to save the employee’s Standard Pay 
Allowances.

Field Description

Code
Enter the code for the Allowance you want to add.
Note: You can click on the Find button or press F9 to get a list of your 
Allowances.

Allowance 
Name

This field displays the name of the Allowance.
Note: If you have selected the option Can Modify Name in the Allowance 
Setup, you can change the name here.

Units Enter the number of Units to pay against this Allowance.

Rate Enter the rate at which the Units should be paid.

Amount Enter the Amount of this Allowance.

Rate Type Enter the Pay Rate Multiplier used for this Allowance.

Periods to 
Tax Over

If the Allowance Type is set to Bonus, enter the number of periods the 
Bonus should be taxed over.
Note: You would normally only enter a value in this field when you pay this 
Allowance to the employee in the Current Pay.

Wage Rate 
Code

Enter the Wage Rate Code of the Hourly Rate at which this Allowance 
should be paid.

Cost Centre Enter the Cost Centre to which this Allowance should be costed.
© Copyright 2012 MYOB Technology Pty Ltd
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Salary

To add a Standard Pay Salary

1 Click on the Salary button.

2 Enter the employee’s Annual Salary. The system will automatically calculate the 
Salary per pay period and the Hourly Rate.

N O T E
Once the salary per pay period is calculated, the system may adjust the Annual Salary to 
reflect the actual annual value paid to the employee.

3 Click on the Save button or press F10 to save the employee’s Standard Pay Salary.

Standard Pay - Salary
© Copyright 2012 MYOB Technology Pty Ltd
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Deductions

To add Standard Pay Deductions

1 Click on the Deductions button.

2 Click on the Add button or press F4.

Standard Pay - Deductions

Standard Pay - Deductions - Add Deduction
© Copyright 2012 MYOB Technology Pty Ltd
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3 Enter the following information:

N O T E
The availability of these fields are determined by the setup of the Deduction.

4 Click on the Save button or press F10.

5 Click on the Save button or press F10 to save the employee’s Standard Pay 
Deductions.

Field Description

Deduction Code
Enter the code of the Deduction you want to add.
Note: You can also click on the Find button or press 
F9 to get a list of your Deductions.

Rate Enter the Rate at which this Deduction is made.

Amount Enter the Amount of this Deduction.

Reducing Balance If the Deduction Type is set to Reducing Balance, 
enter the remaining balance of this Deduction.

Protected Earnings 
Amount

If the Deduction Type is set to Child Support, this 
field will show the protected earnings.

Cost Centre
This field will default to the employee’s Default 
Cost Centre. To have the deduction costed to a 
specific Cost Centre, enter the appropriate code in 
this field.

BSB Number, Account Enter the bank account details for this Deduction.

Reference Enter the Reference for the bank account.
© Copyright 2012 MYOB Technology Pty Ltd
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Superannuation

To add Standard Pay Superannuation Contributions

1 Click on the Superannuation button.

2 Click on the Add button or press F4.

3 A list of your Superannuation Calculations will appear. Double-click on the 
Contribution you want to add.

Standard Pay - Superannuations

Standard Pay - Superannuations - Add Superannuation Contribution
© Copyright 2012 MYOB Technology Pty Ltd
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4 In the Percentage Rate field, enter the rate at which the superannuation should be 
calculated.

5 In the Amount field, enter the amount of the superannuation contribution.

6 In the Fund Number field, enter the employee’s superannuation fund membership 
number.

7 In the Cost Centre field, enter the Costs Centre this Superannuation Contribution 
should be costed to.

8 Click on the Save button or press F10.

N O T E
The availability of these fields are determined by the setup of the Superannuation 
Contribution.

9 Click on the Exit button or press Esc to return to the employee’s Standard Pay.

How Paid

To set up Standard Pay Payment Methods

1 Click on the How Paid  button.

To set up Standard Pay Direct Credit information

1 Click on the Yes option for Direct Credit.

Standard Pay - How Paid
© Copyright 2012 MYOB Technology Pty Ltd
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2 Click on the Add/Edit Direct Credits button.

3 Click on the Add button or press F4.

4 Enter the following information:

Standard Pay - How Paid - Direct Credits

Standard Pay - How Paid - Direct Credits Setup

Field Description

BSB Number, Account Enter the employee’s bank account.

Reference Enter the reference that should appear on the employee’s 
bank statement.

Priority Set the priority order for this bank transfer.
© Copyright 2012 MYOB Technology Pty Ltd
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5 Click on the Save button or press F10.

6 Click on the Save button or press F10 to return to the employee’s How Paid.

To set up Standard Pay Cash Payment information

1 Click on the Yes option to pay a fixed amount in cash. 

2 Enter the amount in the Cash Amount field.

3 Click on the Balance option to pay the balance of the employee’s pay in Cash.

To set up Standard Pay Cheque Payment information

1 Click on the Yes option to pay a fixed amount by cheque. 

2 Enter the amount in the Cheque Amount field.

3 Click on the Balance option to pay the balance of the employee’s pay by cheque.

N O T E
If you make any payments by Cash, the Cash Analysis area will show you the breakdown of 
denominations required to pay the employee.

N O T E
If you are applying any rounding to the employee’s Net Pay, the Rounding field will show 
the value that is rounded from the employee’s Net Pay.

Fixed Dollar Amount, 
Pay Balance of Pay,
Allow Part Payment

Select the type of transfer for this account. Use Fixed Dollar 
Amount for a set amount that has to be transfered every 
pay.
Use Allow Part Payment for transfers if there is sufficient 
funds.
Use Pay Balance of Pay for any remaining money to be 
transfered.
Note: At leasts one of the bank acocunts must be set to Pay 
Balance of Pay.

Required Amount Enter the amount to be transfered to bank accounts set to 
Fixed Dollar Amount or Allow Part Payment.
© Copyright 2012 MYOB Technology Pty Ltd
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Hours Paid

To set up Standard Pay Hours Paid for a Salaried Employee

1 Click on the Hours Paid button.

2 In the The total number of hours paid field, enter the employee’s standard number 
of hours paid.

I M P O R T A N T
The value you enter in this field must be equal to the number of hours entered in the 
Hours per Pay Period field in the Employee Details screen.

3 Click on the Save button or press F10 to save the employee’s Standard Pay Hours 
Paid.

Click on the Save button or press F10 to save the employee’s Standard Pay Payment Setup.

Standard Pay - Hours Paid
© Copyright 2012 MYOB Technology Pty Ltd

 34



Unit 1—Employee Maintenance
Default Payslip Note

To add a Standard Pay Default Payslip Note

1 Click on the Default Payslip Note button.

2 In the space provided enter the default note to appear on the employee’s payslip.

N O T E
This default note can be changed when processing a pay. Any changes to this note will only 
be applicable to that pay.

3 Click on the Save button or press F10 to save the employee’s Default Payslip Note.

Standard Pay - Payslip Note
© Copyright 2012 MYOB Technology Pty Ltd
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Add a new employee

Set up Leave Entitlements

Set up Rostered Days Off Entitlements

Record employee’s e-mail address

Add an employee note

Set up the employee’s Standard Pay information
© Copyright 2012 MYOB Technology Pty Ltd
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Appendices
This unit contains a 
number of appendices 
for further study:
Appendix 1: Migrating employee data from MYOB 
AccoungRight Premier/MYOB PowerPay
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Appendix 1: Migrating employee 
data

If your previous payroll system was MYOB AccountRight or MYOB PowerPay, you can 
migrate your employees’ basic information to EXO Payroll using the Migration Wizard 
available in EXO Payroll.
In order to be migrated using the Migration Wizard, data must be exported from the 
source payroll system in comma-separated format.

To export data from MYOB AccountRight

1 Select Export Data > Cards > Employees from the File menu. This opens the Export 
File window.

2 Select Comma-separated for the Export File Format.

3 Select Header Record for the First Record.

4 Use the fields on the bottom half of the window to specify which employees you 
want to export.
© Copyright 2012 MYOB Technology Pty Ltd
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5 Click Continue.

6 On the Export Data window, click Match All. 

7 Click Export.

8 Enter a name for the export file.

9 Click Save.

To export data from MYOB PowerPay:

1 Select Export Data... from the File menu. This opens the Export Parameters window.

2 Select Employees for the Type of Export.

3 Select Tab Delimited for the Export File Format.

4 Select Header Record for the First Record.

5 Use the fields on the bottom half of the window to specify which employees you 
want to export.
© Copyright 2012 MYOB Technology Pty Ltd
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6 Click Continue.

7 On the Export Employees window, click Match All. 

8 Click Continue.

9 Enter a name for the export file.

10 Click Save.

11 Open the file in Microsoft Excel.

12 Save the file in Comma Separated Values (CSV) format.

To migrate the exported information to EXO Payroll

1 From the Help menu, select Migration Tool. The following window is displayed:

2 Click Next on the Welcome screen.

Migration Wizard
© Copyright 2012 MYOB Technology Pty Ltd
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3 Click Browse to specify the location of the CSV file exported from 
PowerPay/Premier.

4 Click Next.

5 If you are migrating data from MYOB PowerPay, you must map the PowerPay Pay 
Frequencies in the export file to PayrollEnterprise Pay Frequencies. For each 
frequency Code listed, select a Pay Frequency (Weekly, Fortnightly, Bi-monthly, 4 
weekly or Monthly). 

6 Click Next once all Pay Frequencies have been mapped.

7 At this point you must back up your company file before proceeding.

8 Once the backup is completed, the Migration Tool will check that it can read the CSV 
file successfully. 

9 Once the file has passed all the checks, click Next to continue.

10 Select the option I accept full responsibility....

11 Click Migrate to begin the migration operation.

12 The progress of the migration is displayed.

13 Once the migration is complete, the results of the migration are displayed. Click 
Print to print a copy of the migration log. 

N O T E
If any fatal errors were encountered, exit the Migration Tool and correct the problems that 
caused them. 

14 Click Next to continue.

15 Click Finish.

Your employees’ basic information will now migrated to EXO Payroll. You can now 
complete the setup of additional information, e.g. Standard Pay information.
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